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[bookmark: _Toc128655694]About CELA Connect
CELA Connect is computer software that allows you to download titles from your CELA Direct to Player bookshelf to your Envoy Connect player or to your computer. It can also be used to remove content from the player, your Direct to Player bookshelf, and/or computer.

To use CELA Connect you must be a registered CELA patron and have an account number and password. If you are not a registered patron, contact CELA at 1-855-655-2273 or by email at help@celalibrary.ca. 	Comment by Holly Pickering: Updated from "username". Update in french.

CELA Connect is designed for computers running Windows 10 and above; it does not operate on Macs. CELA Connect requires an internet connection to work.
[bookmark: _Toc91855333][bookmark: _Toc128572620][bookmark: _Toc128655695][bookmark: _Toc18311445][bookmark: _Toc18316744][bookmark: _Toc19278059]How to Install
The CELA Connect software can be downloaded by visiting the following link: https://celalibrary.ca/help/envoy-connect. Navigate to the section about CELA Connect and select the link that says “Download CELA Connect”.

Once the CELA Connect software has finished downloading, navigate to where the downloaded software is on your computer. Open the “CELAConnectInstaller.exe” file to begin installation.

During installation, you may be presented with a “Microsoft Windows Security Warning” asking if you want to install the software. Select the “Install” button to begin the installation. A CELA Connect shortcut (icon) will be placed on your desktop when the installation is finished.
[bookmark: _Toc128572623][bookmark: _Toc128655696]Using CELA Connect
For a brief overview on how to use the basic functionalities of CELA Connect, please refer to the Quick Reference Guide.

When you run CELA Connect, the title bar displays the current mode (“Envoy Connect Manual Mode” or “Local Computer Mode”). Most users will want the default mode that is active when starting CELA Connect, “Envoy Connect Manual Mode,” and will not need to change anything. For information on switching modes, see the Switching Between Modes section below.
[bookmark: _Toc128655697]Initial Screens and Buttons
This section describes the main screen and buttons that will appear when you open CELA Connect.
Main CELA Connect Screen
This window allows you to connect to CELA and start the book update process. It contains the “File” and “Help” menus in the top navigation bar, and a “CELA Website” button, “Connect to Library” button, and an “Exit” button at the bottom of the window.
“CELA Website” Button
Click this button to open the CELA website in an internet browser window. On the CELA Library website, you can set user preferences, search for titles to add to your bookshelf, and more.
“Connect to Library” Button
Click this button to link CELA Connect to your CELA Library account. This will start the process to update content on your Envoy Connect player or computer.
“Exit” Button
Select this if you are finished using CELA Connect and want to exit the program.
[bookmark: _Toc128572624][bookmark: _Toc128655698][bookmark: _Toc91855338]Envoy Connect Manual Mode
This section is a detailed step-by-step guide to using CELA Connect in Envoy Connect Manual Mode. This mode lets you both remove and load titles directly on your Envoy Connect player.
1. [bookmark: _Toc128572625]Plug in the Player
Ensure your Envoy Connect player is switched off, then connect your player to the computer using the supplied USB data cable. The player will emit a chime to confirm the connection. If CELA Connect is running before plugging in the player, it will prompt you to plug it in.
2. [bookmark: _Toc91855339][bookmark: _Toc128572626]Open CELA Connect
To run CELA Connect, activate the CELA Connect icon on your computer desktop. 

When you first run CELA Connect, a “Getting Started” guide will appear, providing a brief overview of CELA Connect. You can choose not to display this guide next time you run CELA Connect by deselecting the “Show next time on startup” checkbox. You can also access the “Getting Started” guide as well as the CELA Connect User Guide (this document) at any time from the “Help” menu. Select the “Close” button to proceed.

A message will confirm that an Envoy Connect player is plugged in. Select the “Continue” button to proceed or the “Cancel” button to return to the main screen. To login to CELA from the main screen, select the “Connect to Library” button.
3. [bookmark: _Toc91855340][bookmark: _Toc128572627]Login
If your player is already registered with CELA, the player will be recognized by the system and log in automatically. If your player is not registered, you will be prompted to enter your CELA account number and password.	Comment by Holly Pickering: Changed this from username: ensure this is updated in the French version.

Check the “Save CELA Account Number/Password” checkbox to avoid entering it each time. If your login fails for any reason, the login screen reappears.

Select the “OK” button to proceed. CELA Connect will connect to your CELA Direct to Player bookshelf. Logging in may take a few minutes depending on the size of your Direct to Player bookshelf and the speed of your internet connection. When logging in, a status field will show the progress. Once logged in, this same status field will show the user that is logged in and the associated Envoy Connect device’s serial number.
4. [bookmark: _Toc91855342][bookmark: _Toc128572628][bookmark: _Toc19278061]Select Titles to Remove
[bookmark: _Hlk128581810]Once you are logged in, CELA Connect will display a “Select Titles to Remove” window. This is the list of titles currently on your Envoy Connect player that may be removed to make space for new titles.
You can select as many titles as you would like from the list to remove them from your player. This will also remove them from your Direct to Player bookshelf. If you don’t want to remove any titles, you don’t need to, but over time, the memory on the player will become full, preventing you from downloading new titles. Once you are satisfied with your deletion selections, click the “Next” button to proceed.
5. [bookmark: _Toc91855343][bookmark: _Toc128572629]Select Titles to Download
[bookmark: _Hlk128581872]CELA Connect will display a “Select Titles to Download” window. This is the list of titles currently on your Direct to Player bookshelf that you can download to your Envoy Connect. Select one or more titles from the list to download them to your player.

If this list is empty, your new titles are being prepared in the background. Populating your bookshelf with recently added books may take up to 24 hours. Continue to the next step and check the list again later. Select the “Next” button to proceed, or the “Back” button to return to the previous screen.
6. [bookmark: _Toc91855344][bookmark: _Toc128572630][bookmark: _Toc18311450][bookmark: _Toc18316749][bookmark: _Toc19278071]Confirm Content Update
[bookmark: _Hlk128582042]CELA Connect will tell you how many titles you are deleting and newly downloading. Confirm the selections you have made in the previous two windows by selecting the “Next” button. If you wish to review or change your selections, select the “Back” button. If you use the “Back” button, you will need to reselect any titles you had previously selected. You can select the “Cancel” button if you want to ignore all previous steps and return to the main screen without making any changes.

Once you have confirmed your selections, a status field will show the progress of your download. 

Select the “Cancel” button if you want to stop the process at any time and return to the main screen. Note that if you cancel downloading, only those titles that have completed downloading will be playable on your Envoy Connect. When you next run CELA Connect, you will need to reselect the titles from your bookshelf that were cancelled to resume downloading them.

Downloading content onto your player may take some time depending on how many titles you have selected and the speed of your internet connection. Do not disconnect the player or exit the program until CELA Connect confirms “The content has been updated on your computer.”
7. [bookmark: _Toc91855345][bookmark: _Toc128572631]Update Complete
The update has been completed. Select the “OK” button to return to the main screen of CELA Connect. Select the “Exit” button to close the CELA Connect software.
[bookmark: _Switching_between_Envoy][bookmark: _Switching_Between_Modes][bookmark: _Toc128572632][bookmark: _Toc128655699]Switching Between Modes
There are two main modes of operation for the CELA Connect software:
· Envoy Connect mode: this mode loads or removes Direct to Player bookshelf content on your Envoy Connect player. This is the default mode active when you first open the software, and it is the mode most users will want.
· Local Computer mode: this mode loads or removes Direct to Player bookshelf content on the computer. This mode is useful if you want to download titles to load onto your Envoy Connect later or if you simply want to read your titles on the computer.
To switch modes, go to the “File” menu and then select “Options”. From the “Device Type” dropdown menu, select either “Envoy Connect Player” mode or “Local Computer” mode. Press OK and the software will switch to your selected mode until the next time you choose to switch.
[bookmark: _Toc128572633][bookmark: _Toc128655700]Local Computer Mode 
Local Computer mode is used to download books from your CELA Direct to Player bookshelf to your computer. You don’t need an Envoy Connect player to do this. This can be useful if you don’t have immediate access to your Envoy Connect player and want to download titles for later, or if you simply want to listen to books on your computer. 
1. [bookmark: _Toc128572634]Open CELA Connect
To run CELA Connect, activate the CELA Connect icon on your computer desktop. You will receive a prompt to plug in an Envoy Connect player if the software is currently set to “Envoy Connect Manual Mode”. Dismiss this prompt by clicking “Cancel” and ensure you switch to “Local Computer Mode” as explained above.

When you first run CELA Connect, a “Getting Started” guide will appear, providing a brief overview of CELA Connect. You can choose not to display this guide next time you run CELA Connect by deselecting the “Show next time on startup” checkbox. You can also access the “Getting Started” guide as well as the CELA Connect User Guide (this document) at any time from the “Help” menu. Select the “Close” button.
2. [bookmark: _Toc128572635]Login
To login to CELA from the main screen, select the “Connect to Library” button. A prompt will pop up that says “CELA Connect will download content to your computer. You will now be connected to the library service.” Select “Continue”. A prompt requiring your CELA account number and password will come up. Fill it out with your account details.

Check the “Remember me” checkbox to allow CELA Connect to remember your details, so you can avoid entering your credentials each time. If your login fails for any reason, the login screen reappears.

Select the “OK” button to proceed. CELA Connect will connect to your CELA Direct to Player bookshelf. Logging in may take a few minutes depending on the size of your Direct to Player bookshelf and the speed of your internet connection. When logging in, a status field will show the progress. Once logged in, this same status field will show the user that is logged in.
3. [bookmark: _Toc128572636]Select Titles to Remove
Once you are logged in, CELA Connect will display a “Select Titles to Remove” window. This is the list of titles currently on your computer that may be removed to make space for new titles.

You can select as many titles as you would like from the list to remove them from your computer. This will also remove them from your Direct to Player bookshelf. You don’t have to remove any titles if you don’t want to. Once you are satisfied with your deletion selections, click the “Next” button to proceed.
4. [bookmark: _Toc128572637]Select Titles to Download
CELA Connect will display a “Select Titles to Download” window. This is the list of titles currently on your Direct to Player bookshelf that you can download to your computer. Select one or more titles from the list to download them.

If this list is empty, your new titles are being prepared in the background. Populating your bookshelf with recently added books may take up to 24 hours. Continue to the next step and check the list again later. Select the “Next” button to proceed, or the “Back” button to return to the previous screen.
5. [bookmark: _Toc128572638]Confirm Content Update
CELA Connect will tell you how many titles you are deleting and newly downloading. Confirm the selections you have made in the previous two windows by selecting the “Next” button. If you wish to review or change your selections, select the “Back” button. If you use the “Back” button, you will need to reselect any titles you had previously selected. You can select the “Cancel” button if you want to ignore all previous steps and return to the main screen without making any changes.

Once you have confirmed your selections, a status field will show the progress of your download. 

Select the “Cancel” button if you want to stop the process at any time and return to the main screen. Note that if you cancel downloading, only those titles that have completed downloading will be playable. When you next run CELA Connect, you will need to reselect the titles from your bookshelf that were cancelled to resume downloading them.

Downloading content may take some time depending on how many titles you have selected and the speed of your internet connection. Do not exit the program until CELA Connect confirms “The content has been updated on your computer.”
6. [bookmark: _Toc128572639]Update Complete
The update has been completed. Select the “OK” button to return to the main screen of CELA Connect. Select the “Exit” button to close the CELA Connect software.

When you select Local Computer mode, a new folder called “CELA Connect Content” is placed on your computer desktop. This folder contains a subfolder called “Downloads” and it is where all your downloaded titles are saved.
[bookmark: _Toc91855354][bookmark: _Toc128572645][bookmark: _Toc128655701]File Menu
[bookmark: _Toc91855355][bookmark: _Toc128572646]This section details the contents of the “File” menu in the navigation bar at the top of the main CELA Connect window.
[bookmark: _Toc128655702]Options
Device Type
You can select between two main device types to use with CELA Connect.

[bookmark: _Toc91855357]Envoy Connect Player
Select this option to download items from your Direct to Player bookshelf onto your Envoy Connect player. This is the default option when you install CELA Connect and is the option most people will want.

[bookmark: _Toc91855358]Local Computer
Select this option to download items from your Direct to Player bookshelf onto your computer. Files will be saved to a folder on your desktop called “CELA Connect Content” that is created when you select this option.
[bookmark: _Toc91855359][bookmark: _Toc128572648]Player Loading Mode
If you have chosen Envoy Connect as your device under “Device Type,” there are two loading modes that can be chosen from.

[bookmark: _Toc91855360]Manual
This option is the only one supported by CELA. It allows you to delete titles from your Envoy Connect, and to download new titles from your CELA bookshelf onto your player.

[bookmark: _Toc91855361]Automatic
While this mode is available, CELA does not support or recommend it.

Selecting this mode will delete all content from your Envoy Connect, as well as all content currently on your Direct to Player bookshelf without asking for any input or confirmation.

Please ignore this option when using CELA Connect.
[bookmark: _Toc91855362]Show “Getting Started” on Startup
Selecting or deselecting this option displays or disables display, respectively, of the “Getting Started” guide upon starting CELA Connect. 
[bookmark: _Toc91855363]Clear Saved CELA Account Number/Password
If you previously chose to save your account number and password when logging in to CELA Connect, clicking the “Clear Saved CELA Account Number/Password” button erases this information from the program’s memory.
This will prevent unauthorized access to your account if someone else would like to use CELA Connect on your computer or if you are using CELA Connect on a public computer.
[bookmark: _Toc91855364][bookmark: _Toc18311455][bookmark: _Toc18316754][bookmark: _Toc19278076]Use Default Location on Local Computer
The “Use default location on Local Computer” checkbox is selected by default. This saves downloaded titles to the “CELA Connect Content” folder on your computer desktop if you are using Local Computer Mode. The “Content Location” field will display the file path of the download folder.

You can choose a different location by ‘unticking’ the checkbox and then selecting “Browse”. This opens a “Browse for Folder” window where you can choose a different location for your downloads on your computer. Select the “OK” button to save your preferred location. Use the “Cancel” button to return to the Options menu without saving your changes. 
[bookmark: _Toc91855365][bookmark: _Toc128572649]Exit the Options Menu
After you set your preferences, select the “OK” button to save your changes and return to the main screen. CELA Connect will remember the currently selected settings each time you run the software. Select the “Cancel” button to return to the main screen without saving your changes.
[bookmark: _Toc128572650][bookmark: _Toc128655703]Open Content Location
This opens the “CELA Connect Content” folder in Windows File Explorer. This is where your downloaded items will be saved if you are using Local Computer Mode. This menu item is only visible if you are in this mode.
[bookmark: _Toc91855367][bookmark: _Toc128572651][bookmark: _Toc128655704]CELA Website
This opens the CELA Library website in an internet browser window. On the CELA Library website, you can set user preferences, search for titles to add to your bookshelf, and more.
[bookmark: _Toc91855368][bookmark: _Toc128572652][bookmark: _Toc128655705]Exit
Select Exit to close CELA Connect.


[bookmark: _Toc91855369][bookmark: _Toc128572653][bookmark: _Toc128655706]Help Menu
[bookmark: _Toc128655707]Getting Started
This opens the CELA Connect “Getting Started” window. This window will tell you about any new changes to the software if it has been recently updated.

You can choose if this window is displayed when you run CELA Connect by selecting or deselecting the “Show next time on Startup” checkbox. Select the “Close” button to return to the main screen.
[bookmark: _Toc91855371][bookmark: _Toc128572655][bookmark: _Toc128655708]User Guide
This opens the CELA Connect User Guide, an in-software version of this document you are currently reading. Select the “Close” button to return to the main screen.
[bookmark: _Toc91855372][bookmark: _Toc128572656][bookmark: _Toc128655709]About
This will display a window with information about CELA Connect, including the version number of the software as well as CELA contact details. Select the “OK” button to return to the main screen.
[bookmark: _Toc91855373][bookmark: _Toc128572657][bookmark: _Toc128655710]New Versions of CELA Connect
Each time you run CELA Connect, it checks if a newer version is available. If a software update is available, it will automatically update.

When a software update occurs, a progress status screen will appear momentarily. You do not need to do anything. When the software update is finished, CELA Connect will open as normal.
If a software update has occurred, the “Getting Started” window will be displayed and describe what’s new in the latest version of CELA Connect.
[bookmark: _Toc91855374][bookmark: _Toc128572658][bookmark: _Toc128655711]Contact and Support
We want your experience using CELA Connect to be as good as possible. If you have any questions or require assistance with the software, please contact CELA at 1-855-655-2273 or email help@celalibrary.ca.
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